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Cautions and Warnings 
Definitions 
Cautions indicate that there is the possibility of poor equipment performance or potential damage to the 
equipment. Warnings indicate that there is the possibility of injury to person. Cautions and Warnings 
appear here and may appear in this manual where appropriate. Failure to read and understand the 
information identified by these symbols could result in poor equipment performance, damage to the 
equipment, or injury to persons.  

 Cautions 

Do not ship or store devices near strong electrostatic, electromagnetic, magnetic, or radioactive fields.  

Caution: When handling chassis Network Interface Devices (NIDs) observe electrostatic discharge 
precautions. This requires proper grounding (i.e., wear a wrist strap). 
Caution: Copper based media ports, e.g., Twisted Pair (TP) Ethernet, USB, RS232, RS422, RS485, 
DS1, DS3, Video Coax, etc., are intended to be connected to intra-building (inside plant) link segments 
that are not subject to lightning transients or power faults. They are not to be connected to inter-building 
(outside plant) link segments that are subject to lightning. 
Caution: Do not install the NIDs in areas where strong electromagnetic fields (EMF) exist. Failure to 
observe this caution could result in poor NID performance.  
Caution: Read the installation instructions before connecting the chassis to a power source. Failure to 
observe this caution could result in poor performance or damage to the equipment. 
Caution: Only trained and qualified personnel should install or perform maintenance on the ION NID. 
Failure to observe this caution could result in poor performance or damage to the equipment. 
Caution: Do not let optical fibers come into physical contact with any bare part of the body since they are 
fragile, and difficult to detect and remove from the body.  
Caution: Do not bend any part of an optical fiber/cable to a diameter that is smaller than the minimum 
permitted according to the manufacturer’s specification (usually about 65 mm or 2.5 in)! 

 Warnings 
Warning: Use of controls, adjustments or the performance of procedures other than those specified 
herein may result in hazardous radiation exposure.  
Warning: Visible and invisible laser radiation when open. Do not stare into the beam or view the beam 
directly with optical instruments. Failure to observe this warning could result in an eye injury or blindness.  
Warning:  DO NOT connect the power supply module to external power before installing it into the 
chassis. Failure to observe this warning could result in an electrical shock or death. 
Warning: Select mounting bracket locations on the chassis that will keep the chassis balanced when 
mounted in the rack. Failure to observe this warning could allow the chassis to fall, resulting in equipment 
damage and/or injury to persons. 
Warning: Do not work on the chassis, connect, or disconnect cables during a storm with lightning. Failure to 
observe this warning could result in an electrical shock or death. 
High Risk Activities Disclaimer: Components, units, or third-party products used in the product 
described herein are NOT fault-tolerant and are NOT designed, manufactured, or intended for use as on-
line control equipment in the following hazardous environments requiring fail-safe controls: the operation 
of Nuclear Facilities, Aircraft Navigation or Aircraft Communication Systems, Air Traffic Control, Life 

https://www.lantronix.com/
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Support, or Weapons Systems ("High Risk Activities"). Lantronix and its supplier(s) specifically disclaim 
any expressed or implied warranty of fitness for such High Risk Activities. 
See Appendix A:  Warranty and Compliance Information for Electrical Safety Warnings translated into 
multiple languages.  

https://www.lantronix.com/


Lantronix                  ION C4221 Install Guide 

33692 Rev. C  https://www.lantronix.com/ Page 5 of 38 

Contents 
1:  Introduction ............................................................................................................................................ 6 

Product Description .................................................................................................................................. 6 

About This Manual .................................................................................................................................... 6 

Physical Specifications ............................................................................................................................. 7 

Fiber Specifications .................................................................................................................................. 7 

2:  Installation and System Setup .............................................................................................................. 9 

3:  Troubleshooting ................................................................................................................................... 22 

Appendix A:  Compliance Information .................................................................................................... 35 
Electrical Safety .................................................................................................................................. 37 
Elektrische Sicherheit ......................................................................................................................... 37 
Elektrisk sikkerhed.............................................................................................................................. 37 
Elektrische veiligheid .......................................................................................................................... 37 
Sécurité électrique .............................................................................................................................. 37 
Sähköturvallisuus ............................................................................................................................... 37 
Sicurezza elettrica .............................................................................................................................. 37 
Elektrisk sikkerhet............................................................................................................................... 37 
Segurança eléctrica ............................................................................................................................ 37 
Seguridad eléctrica ............................................................................................................................. 37 
Elsäkerhet ........................................................................................................................................... 37 

 
List of Figures 
Figure 1:  Chassis Installation ....................................................................................................................... 9 
Figure 2:  Model C4221 Connectors and LEDs .......................................................................................... 10 
Figure 3:  SFP Installation ........................................................................................................................... 11 
 

List of Tables 
Table 1: Chassis SIC (C4221) Specifications ............................................................................................... 7 
Table 2: C4221 Connectors Descriptions ................................................................................................... 10 
Table 3: C4221 LED Descriptions ............................................................................................................... 10 
Table 4: Copper Cable Descriptions ........................................................................................................... 28 
 

https://www.lantronix.com/


Lantronix                  ION C4221 Install Guide 

33692 Rev. C  https://www.lantronix.com/ Page 6 of 38 

1:  Introduction 

Product Description 
The ION C4221 Network Interface Device (NID) is a remotely managed product that offers management 
via the IONMM for secure delivery of Ethernet services for business and mobile backhaul applications. 
The C4221 is a 10 Gbps product with advanced features like remote management of the local and 
remote cards, VLAN, jumbo frame support, and bandwidth allocation of 10G interfaces.  

The C4221 offers the additional functionality of a rate converter by also offering a 10/100/1000Base-T 
RJ-45 port allowing 10/100/1000 based devices to connect to 10 Gigabit Ethernet fiber backbone. 

About This Manual 
This manual provides information on the specifications, installation and setup, troubleshooting, 
warranty and compliance, and safety cautions and warnings regarding the Lantronix C4221 network 
interface devices (NIDs). Note: Some Documentation may have Transition Networks named or pictured. 
Transition Networks was acquired by Lantronix in August 2021. 

This manual documents these models: 

Model Description 

C4221-4848 
ION Chassis Card, two 10G SFP+ ports, one 10/100/10000 Base-T copper port  
Remotely-Managed NID 

Features 
See the C4221 Web User Guide for features. 

Chassis Model (C4221)  

The ION Chassis model (also called slide-in-card or SIC, or slide-in-module) and managed NIDs (Network 
Interface Devices) have specific features and functions that are controlled via the ION Management 
Module (IONMM). A network administrator can configure, monitor and troubleshoot ION slide-in-
modules remotely via the IONMM.  

The ION C4221 can be used in the ION 19-Slot, 6-Slot, and 1-Slot chassis.  

 
  

https://www.lantronix.com/
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Physical Specifications 
The physical specifications for the C4221 chassis slide-in-cards are provided in Table 1 below.  

Table 1: Chassis SIC (C4221) Specifications  

Standards IEEE 802.3, IEEE 802.3ah, IEEE 802.1p, IEEE 802.1Q, IEEE 802.1x, IEEE 
802.3u, IEEE 802.3x, IEEE 802.3z, IEEE 802.3ab, IEEE 802.3xae 

Ports  
One Copper RJ-45 10/100/1000Base-T port;  
Two Fiber 10Gig SFP+ ports supporting 100FX, 1000X, SGMII;  
One 10G USB port for basic setup. 

Status LEDs 

Power 
SFP+ Link/Activity for each port 
TP – Left LED: Duplex, TP Link/Activity 
TP – Right LED: TP Speed 
USB - Activity 

Switches/Jumpers One jumper to load factory defaults 
Fuse 120mA hold,290mA trip,24V/10A,SMT1206 

Dimensions 
Width: 0.86 inches (21.85 mm) 
Depth: 6.5 inches (165 mm) 
Height: 3.4 inches (86.36 mm) 

Power Input ION Chassis backplane 

Environment 

Operating Temp.: 0°C to 50°C (32 to 122°F) 
Storage Temp.: -40°C to 50°C 
Humidity: 5% - 95% (non-condensing)   
Altitude: 0 to 10,000 ft. 

Compliance Safety: CE Mark; Emissions: EN55022 Class A; Immunity: EN55024;  
TAA Compliant and NDAA Compliant 

Weight 0.3 Lb. (0.13 Kg.) 

Power Consumption 520 mA @ 12 V (6.24W) (with two TN-10GSFP-SR modules installed) 

MTBF 

MTBF to be greater than 250,000 MIL-HDBK-217F Hours. 
MTBF to be greater than 687,500 Bellcore Hours. 
Prediction Method: MIL-HDBK-217F Parts Count. 
Environment: GB, Ground Benign. Temperature 25°C 

Warranty 10 Years 

Fiber Specifications 
For possibly updated information go to the C4221 Product page.   
 
 

https://www.lantronix.com/
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Related Manuals and Online Helps 
A printed documentation card is shipped with each C4221 NID. Context-sensitive Help screens, as well as 
cursor-over-help (COH) facilities are built into the Web interface.  

For Lantronix Drivers, Firmware, Manuals, Product Notifications, Warranty Policy & Procedures, etc. go 
to the Lantronix Technical Resource Center. 

ION system and related device manuals are listed below. 

1. ION C4221 Install Guide, 33692 (this manual) 
2. ION C4221 Web User Guide, 33693                                                
3. ION C4221 CLI Reference, 33694                                                    
4. ION Management Module (IONMM) User Guide, 33457 and Install Guide, 33420 
5. IONMM-232 Install Guide, 33725 
6. ION219-x 19-Slot Chassis Installation Guide, 33412 
7. ION106-x Six Slot Chassis User Guide, 33658  
8. IONPS-A-R1 Power Supply User Guide, 33614 
9. IONPS-D-R1 DC Power Supply Install Guide, 33707 
10. ION Dry Contact Relay (DCR) Kit Install Guide, 33483 
11. SFP manuals (model specific) (see Lantronix SFP webpage) 
12. Release Notes (software version specific) 

This manual may provide links to third party web sites for which Lantronix is not responsible. 
Information in this document is subject to change without notice. All information was deemed accurate 
and complete at the time of publication. This manual documents the latest software/firmware version. 
While all screen examples may not display the latest version number, all of the descriptions and 
procedures reflect the latest software/firmware version, noted in the Revision History on page 2. 

https://www.lantronix.com/
https://www.lantronix.com/technical-support/
https://www.lantronix.com/products-class/sfps/
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2:  Installation and System Setup 

General 
This section describes how to install the C4221 and the procedures to access and initially set up the NID 
through either a local serial interface (USB) or a remote Ethernet connection (SSH/Telnet session or Web 
UI). 

Installing the Chassis Model (C4221) 
The C4221 NID is a slide-in module that can only be installed in a Lantronix ION106-x and ION219-x 
chassis. For a complete list of ION platform products, go to the Lantronix Technical Resource Center.  

This section describes how to install the C4221 in the ION chassis.  

  Caution: Failure to wear a grounding device and observe electrostatic discharge precautions 
when installing the C4221 could result in damage or failure of the module.  

 
Figure 1:  Chassis Installation 

Important:  The C4221 slide-in cards are “hot swappable” devices, and can be removed and installed 
with chassis power on. 

1. Locate an empty slot in the ION System chassis.  
2. Grasp the edges of the card by its front panel. 
3. Align the card with the upper and lower slot guides, and carefully insert the card into the slot. 
4. Firmly seat the card against the chassis back panel. 
5. Push in and rotate clockwise the panel fastener screw to secure the card to the chassis (Figure 1). 
6. Note that the card’s Power LED lights. See “Accessing the NIDs”.  
7. Disable the C4221 link partner’s fiber auto-negotiation to establish a link with the C4221. Auto-

negotiation on the C4221 is not currently configurable to enable/disable.  

https://www.lantronix.com/
https://www.lantronix.com/technical-support/
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Connections and LEDs 

The C4221 connectors and LEDs are shown and described below. 

 

Figure 2:  Model C4221 Connectors and LEDs 

Table 2: C4221 Connectors Descriptions 

Connector Description 

10GE SFP+ 
SFP port connectors (x2) 

Let you install a Small Form-Factor Pluggable (SFP) device of your choice in 
order to make a fiber connection. Labeled ports ① and ②.  

10/100/1000  
Copper port connector 

One connector for Ethernet 10/100/1000 Base-T. The RJ-45 connectors 
allow the network administrator to manage the chassis through a remote 
computer using either remote SSH/Telnet session or the Web interface.  
Labeled port ③. 

USB connector 
USB Type B connector to connect the NID to a PC for a direct serial 
interface. This connection lets a system administrator access and control 
the NID using CLI commands.  

Table 3: C4221 LED Descriptions 

LED Description 

L/A  
(Link active) 
LED 

TP (Left LED) = Half duplex TP Link/Activity. Yellow On = Link.  
Yellow Blinking = activity. 
TP (Left LED) = Full duplex TP Link/Activity. Green On = Link.  
Green Blinking = activity. 
TP (Right LED) = Speed: 10 Mbps = OFF. 100 Mbps = Yellow.  
1000 Mbps = Green. 

PWR (Power) LED When on (green), indicates that there is power to the NID.  

USB LED USB = Activity: Green on = USB port Activity.  

 
  

https://www.lantronix.com/
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Installing SFPs 

The ION C4221 models allow you to install a Small Form-Factor Pluggable (SFP) device of your choice to 
make a fiber connection. See the Lantronix  SFP webpage for models, safety precautions, and warnings 
specific to your SFP model. See the related SFP manual for more information. 

 

Figure 3:  SFP Installation 

1. Position the SFP device at either installation slot, with the label facing correctly. 
2. Carefully slide the SFP device into the slot, aligning it with the internal installation guides. 
3. Ensure that the SFP device is firmly seated against the internal mating connector. 
4. Connect the fiber cable to the fiber port connector of the SFP device.  

Operating Systems Supported 

The ION system supports the current version of most popular operating systems. 

The USB drivers are available at the Lantronix Technical Resource Center.  

Virtual COM port (VCP) drivers make the USB device appear as another COM port available to the PC.  
Application software can access the USB device in the same way as it would access a standard COM 
port.  

The C4221 provides a USB port that can be used as a virtual COM port for accessing the C4221 command 
line interface (CLI). 

  

https://www.lantronix.com/
https://www.lantronix.com/products-class/sfps/
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Installing the USB Driver (Windows 7) 

To install the USB driver on a computer running Windows 7, do the following. 

1. Extract the driver from the Lantronix Technical Resource Center and place it in an accessible folder 
on the local drive of the PC. WHQL Certified driver files are at https://ftdichip.com/drivers/.  

2. Connect the NID to a spare USB port on the PC. 

3. At File Download, select Save. At Save As, select the filename and Save in location. Click Save.  

4. If there is an available Internet connection, Windows 7 will silently connect to the Windows Update 
website and install any suitable driver it finds for the device.  
If the automatic installation takes place, there is no need to continue with the procedure below.  
If no suitable driver is automatically found, then follow the remaining procedure below. 

5. Press the Windows start button to bring up the start menu and select “Control Panel”. 

6. From the Control Panel window select Hardware and Sound. 

7. At the next screen select Device Manager. 

8. In the Device Manager window there will be a device under Other Devices with a yellow warning 
symbol to indicate a problem (i.e., no driver installed). The text next to this device will depend on 
the device attached.  

9. Right click on the other device to bring up a menu. 

10. From the displayed menu select “Update Driver Software…”  
This menu displays the option for an automatic search or a manual search. 

11. Select the second option (“Browse my computer ...”) to browse manually. 

12. In the address box, enter the exact location where you saved the drivers in step 11. This may be on a 
CD or in a folder on the PC.  

13. After entering the address, select “Next” to start the installation. A completion screen displays when 
the installation has finished. 

14. Press “Close” to close this window and go back to the Device Manager Window. 

15. The Device Manager will still show a device under Other Devices, but in addition to this there is a 
new entry under Universal Serial Bus Controllers. This indicates the bus layer of the driver is 
installed. Installing the Virtual Com Port layer of the driver is almost a repeat of the last few steps. 

16. Right click on the other device  to bring up a menu as shown below. 

17. From the displayed menu select “Update Driver Software…” 
This displays the option for an automatic search or a manual search. 

18. Select the second option (“Browse my computer ...”) to browse manually.  

19. In the address box, enter the exact location where the drivers have been saved to. This is in a folder 
on the PC.  

20. After entering the address select “Next” to start the installation. When the installation is finished, a 
completion screen displays. Note that this screen also displays the COM port assigned to the device. 

https://www.lantronix.com/
https://www.lantronix.com/technical-support/
https://ftdichip.com/drivers/
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21. Press “Close” to close this window and go back to the Device Manager window. 

22. This time the Device Manager does not have the entry under Other Devices, but it does show entries 
under Universal Serial Bus Controllers and Ports (COM & LPT). The device is now ready to use on 
COM3. Note: Not all devices will install to COM3. The COM port allocation is determined by the 
installation wizard on the basis of the next free com port as designated in the PC registry. 

Uninstalling the USB Driver (Windows 7) 
With the release of Microsoft Windows 7, only the system itself is allowed to modify files and registry 
values in these locations. 

Devices can be removed using the Device Manager by simply right-clicking on the mouse and selecting 
"Uninstall". This will delete the associated registry entries for that device only. Windows 7 provides an 
automatic method to delete driver files via a check box to "Delete the driver software for this device" 
on the uninstall dialog box. 

This stage is done twice. Once for the device under Ports (COM & LPT) and once for the device under 
Universal Serial Bus Controllers. 

Some points to note about the new un-install method: 

• In the case of FT2232 / FT4232 devices, a composite device is also installed. This can also be 
removed by right-clicking and selecting "Uninstall". There is no option to delete the driver files 
when doing this, as the driver for the composite device is a native Windows driver.  

• If the VCP driver has been installed, uninstall the COM port driver before uninstalling the bus driver. 
If the bus is uninstalled first, the COM port will no longer appear in the Device Manager.  

• If the files are deleted while other installed devices still require them, those devices will not work 
correctly. This can be fixed by right clicking the device and selecting "Reinstall Driver" which will 
replace the missing files.  

• If a device to be uninstalled is not connected to the PC, the device can still be removed by setting 
the device manager to show phantom devices. This also allows a virtual COM port to be uninstalled 
if the bus layer has been removed first. 

https://www.lantronix.com/
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Troubleshooting USB Driver (Windows 7) Messages 
Message: Windows 7 cannot find drivers for my device 
Meaning: This error can occur if the VID and PID programmed into the device EEPROM do not match 
those listed in the INF files for the driver. The VID and PID programmed into the device EEPROM may be 
found by using the USBView utility from the FTDI web site. These can then be checked against the VID 
and PID entries in the driver INF files. If they do not match, that driver cannot be installed for that device 
without either re-programming the device EEPROM or modifying the list of VID and PID numbers in the 
INF files. 
Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use 
by the customer should be used in the EEPROM and INF files. End customers should obtain modified 
drivers from the OEM of the device, and not necessarily edit the files themselves. 
Recovery:  
1. Check the Lantronix website for more information.  
2. If the problem persists, contact Technical Support.  

Message: Devices not shown in Device Manager for uninstalling 
Meaning: Devices that have been installed on a system but are not currently available are referred to as 
"phantom devices". These devices are not usually displayed in the device manager, but can be made to 
be displayed as though they are attached. This allows device properties to be changed or devices to be 
uninstalled via Device Manger even though the device is not physically connected to the PC. 
Recovery:  
1. To display phantom devices in Device Manager, a new system variable is required. Open "Control 

Panel > System" then select the "Advanced" tab and click "Environment Variables".  

2. In the System Variables section (NOT THE USER VARIABLES SECTION), click "New..." to display the 
following window: 

3. Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, 
then click OK. 

4. Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click 
"Device Manager…", or "Control Panel > Device Manger" in Windows 7) and select "View > Show 
Hidden Devices".  
Device Manager will then show all hidden and phantom devices available on that PC as shaded. 

 
  

https://www.lantronix.com/
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https://www.lantronix.com/technical-support/


Lantronix                  ION C4221 Install Guide 

33692 Rev. C  https://www.lantronix.com/ Page 15 of 38 

Message: Windows shows a warning that the driver is not certified 
Meaning: If the driver is not certified, then a pop up window such as shown below displays. 

 

Recovery:  

1. If you are certain of the source of the driver the warning can be ignored and you can continue 
installation by selecting “Install this driver software anyway”. 

2. If you are unsure about the driver source, check the Lantronix website for more information.  
3. If the problem persists, contact Technical Support.  
 

Message: Driver will not install on Windows 7 x64 
Meaning: Windows 7 x64 OS will only allow certified drivers to be installed. The certified driver supplied 
by FTDI will work with VID 0403 and PID 6001 for FT232 and FT245 devices. It will also work with VID 
0403 and PID 6010 for FT2232 devices and VID 0403 and PID 6011 for FT4232. 
If you have a product where the manufacturer has customized the driver but has not re-certified it, then 
the driver will not load. Contact your vendor to determine if they will support Windows 7 x64. 
Recovery:  
1. Check the Lantronix website for more information.  
2. If the problem persists, contact Technical Support.  

Problem: Can't launch in Windows Vista 64 bit 
Can't launch on PC with Windows 7 
Application cannot run as a standard user in Windows 7 
Meaning: The standard user account type in Windows 7 provides a limited set of permissions needed for 
most non-administrative application scenarios. Some application tasks are considered administrative 
tasks that always require administrative privileges. These tasks cannot be accomplished by using a 
standard user account. 
This issue is caused when the User Account Control (UAC) setting is "on". The UAC feature was 
introduced in Windows Vista as a way to separate regular user's activities from administrative user 
activities. UAC is a security component that allows an administrator to enter credentials during a non-
administrator's user session to perform occasional administrative tasks in Windows 7, Windows Server 
2008, Windows Server 2008 R2, Windows Storage Server 2008 R2, Windows Vista.  
 

https://www.lantronix.com/
https://www.lantronix.com/technical-support/
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UAC uses a security infrastructure feature called 'tokens'. A security token is a way to grant an object (a 
user, process, file, thread, etc.) a specific set of permissions for specific actions.  

Under UAC, regular users are granted a permission token that lets them do things allowed only to 
regular users. If the user tries to do something that requires admin privileges, UAC asks for admin 
credentials. If the credentials are valid, the user is given a security token for just that one action and 
nothing else.  

An admin account running under UAC has two tokens: one for daily regular-user work and one for 
admin-level privileges. Most programs (e.g., Internet Explorer) are launched under the first token. If you 
want something run as admin, UAC will poll you for permission first, and then launch the app using the 
second token. In Windows 7, UAC was changed so that certain signed system binaries (like Control Panel 
apps) no longer required explicit UAC approval to run. Other system programs (like Internet Explorer) 
were rewritten to automatically poll the user for admin privileges when doing things like copying files 
into the Programs directory. 

Windows 7 has ten Group Policy settings that can be configured for User Account Control (UAC):  

#  Group Policy setting               Default 
1. Admin Approval Mode for the built-in Administrator account      Disabled 
2. Allow UI Access apps to prompt for elevation without using secure desktop  Disabled 
3. Behavior of elevation prompt for admins in Admin Approval Mode    Prompt for consent for  
                    non-Windows binaries 
4. Behavior of the elevation prompt for standard users   Prompt for credentials on secure desktop 
5. Detect application installations and prompt for elevation   Enabled (home) / Disabled (enterprise) 
6. Only elevate executables that are signed and validated       Disabled 
7. Only elevate UI Access applications that are installed in secure locations    Enabled 
8. Run all administrators in Admin Approval Mode         Enabled 
9. Switch to the secure desktop when prompting for elevation      Enabled 
10. Virtualize file and registry write failures to per-user locations     Enabled 

 Turn UAC On or Off 
1. Open User Account Control Settings by clicking the Start button and then clicking Control Panel.  
2. In the search box, type uac, and then click Change User Account Control settings.  
3. Turn UAC off.  Move the slider to the Never notify position, and then click OK.  If prompted for an 

administrator password or confirmation, type the password or provide confirmation.  
4. Restart your computer for UAC to be turned off.  
To turn UAC on, move the slider to choose when you want to be notified, and then click OK.   
If prompted for an administrator password or confirmation, type the password or provide confirmation. 

See also:  
http://msdn.microsoft.com/en-us/library/dd446675(v=ws.10).aspx  
http://technet.microsoft.com/en-us/library/dd835564(WS.10).aspx 
http://technet.microsoft.com/en-us/library/dd919180(WS.10).aspx    
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Configuring HyperTerminal 

After the USB driver has been installed, you must set up the terminal emulator software (e.g., 
HyperTerminal) to use the USB COM port. 

1. On the desktop, right-click on My Computer. 
2. Select Manage. The Computer Management window displays.   
3. Click on Device Manager to open the Device Manager panel. (If a Device Manager message 

displays, click OK and continue.) 
4. In the right panel, expand the list for Ports (COM & LPT). 

Write down the USB COM port number for the “TNI CDC USB to UART” listing (COM 5 in the 
example above). You will need to provide this COM port number in step 8 below.  

5. Launch the HyperTerminal software. 
a)  Click Start.  
b)  Select: All Programs > Accessories > Communications 
c)  Click HyperTerminal. 
The Connection Description window displays.   

6. Type in a name and select an icon that will be used for this connection. 
7. Click OK.  The Connect To window displays.   
8. From the drop-down list in the Connect using field, select the COM port noted in step 4. 
9. Click OK. The Port Settings window displays. 
10. Set the COM port properties as follows: 

•  Bits per second: 115200 
•  Data bits: 8 
•  Parity: None 
•  Stop bits: 1 
•  Flow control: None 

11. Click OK. A blank HyperTerm window displays. 
12. In the HyperTerm window, select File > Properties.  The Properties window displays the Connect 

To tab. 
13. Click the Settings tab. 
14. In the Emulation field, select VT100. 
15. Click the ASCII Setup… button. 
16. Verify that Wrap lines that exceed terminal width is selected. 
17. Click OK and then click OK again. 
18. Login (see Starting a USB Session below). 
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Starting a USB Session in HyperTerminal 

The procedure below describes how to access the C4221 via a USB connection. The  C4221 can be 
controlled from a remote management station via a HyperTerminal session over an Ethernet 
connection. The C4221 can be controlled and configured with CLI commands. Use the following 
procedure to  access the C4221 via a HyperTerminal (HT) session. 

1. Click Windows Start.  
2. Select All Programs > Accessories > Communications > HyperTerminal.  
3. Create a new HT connection (select File > New) or select an existing connection (File > Open).  
4. Press the Enter key. The Password prompt displays. If “Login incorrect” displays, ignore it.  

 
If the login prompt does not display, try unplugging and re-plugging the USB cable at the 
IONMM.  
If your system uses a security protocol (e.g., RADIUS, SSH, etc.), you must enter the login and 
password required by that protocol. 

5. Type ION (all upper case) and press the Enter key. The login prompt displays.  
6. Type private (all lower case) and press the Enter key. The ION system command prompt 

displays. For example: 

  
 
Hello, this is ION command line (version 1.00). 
Copyright 2009 Lantronix. 
 
Agent III C1|S1|L1D> 

7. Continue by entering ION CLI commands to the right of the > symbol. Press the Enter key after 
each command. 

8. If the is NID controlled by the IONMM, go to step 9.  Otherwise continue with step 10. 
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9. Enter a go command to change the location of the command prompt. The go command format 
is:   

go [c=<1-16>] [s=<1-32>] [l1ap=<1-15>] [l2ap=<1-15>] (l1p=<1-5>|l2p=<1-15>|l3p=<1-15>|l1d|l2d|l3d)  

(for a slide in card), or  

  go [c=<0-16>] [s=<0-32>] [l1ap=<1-15>] [l2ap=<1-15>] (l1p=<1-5>|l2p=<1-15>|l3p=<1-15>|l1d|l2d|l3d) 

  (for a standalone card).  

10. Enter commands to set up the various configurations for the NID. For a description of all 
available CLI commands see the ION Systems CLI Reference Manual, 33461. 

Note: If required by your organization’s security policies and procedures, use the CLI command set 
community write=<xx> to change the default password. See the ION Systems CLI Reference Manual, 
33461. 

Terminating a USB Connection from HyperTerminal 

To terminate the USB connection, do the following. 

1. At the command prompt, type q(uit). 

2. Press Enter. 

3. Click Call > Disconnect.  

4. Click File > Exit.  

Note that Telnet is not secure and can expose data to potential eavesdroppers. Consider using SSH for 
more secure communications. Per a Microsoft Tutorial dated 5/29/24 (https://learn.microsoft.com/en-
us/windows/terminal/tutorials/ssh): "The latest builds of Windows 10 and Windows 11 include a built-in 
SSH server and client that are based on OpenSSH, a connectivity tool for remote sign-in that uses the 
SSH protocol. OpenSSH encrypts all traffic between client and server to eliminate eavesdropping, 
connection hijacking, and other attacks. Windows has a built-in SSH client and SSH server that you can 
use in Windows Terminal." 

Windows 10: Microsoft announced it was bringing an integrated OpenSSH client to Windows in 2015. 
They've hidden an SSH client in Windows 10 Fall Creators Update. You can now connect to a Secure Shell 
server from Windows without installing PuTTY or any other third-party software. 

Windows 11: See the “Get started with OpenSSH for Windows” article (https://learn.microsoft.com/en-
us/windows-server/administration/openssh/openssh_install_firstuse?tabs=gui&pivots=windows-server-
2025) dated 08/16/2024. The article applies to Windows 11, Windows 10, Windows Server 2025 and 
2022, and Windows Server 2019.  
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Access via an Ethernet Network 

The NID can be managed remotely through the Ethernet network via either an SSH or Telnet session or 
the Web UI.  

Starting a Telnet Session 
The NID can be controlled from a remote management station via an SSH or Telnet session over an 
Ethernet connection. The NID can be controlled and configured via CLI commands. Use the following 
procedure to connect to and access the system via a Telnet session. 

1. Click Start. 
2. Select All Programs > Accessories. 
3. Click Command Prompt. The command prompt window displays.  
4. At the command line type: telnet <xx>   where xx = IP address of the NID. 
5. Press Enter.  The login prompt displays. 
6. Type your login (the default is ION). Note: the login is case sensitive. 
7. Press Enter. The password prompt displays. 
8. Type your password (the default is private). Note:  the password is case sensitive. 
9. Press Enter.  The command line prompt displays. 

 
10. If the NID is controlled by the ION Management Module, go to step 11. 

If the NID is not controlled by the ION Management Module, go to step 12.  
11. Enter a go command to change the location for the command prompt. The go command format 

is:  go [c=<1-16>] [s=<1-32>] [l1ap=<1-15>] [l2ap=<1-15>] (l1p=<1-5>|l2p=<1-15>|l3p=<1-
15>|l1d|l2d|l3d) 
for a slide in card, or  
go [c=<0-16>] [s=<0-32>] [l1ap=<1-15>] [l2ap=<1-15>] (l1p=<1-5>|l2p=<1-15>|l3p=<1-
15>|l1d|l2d|l3d) 
for a standalone NID.  

12. Enter commands to set up the various configurations for the NID. For a description of all 
available CLI commands see the ION Systems CLI Reference Manual, 33473. 

13. To terminate the Telnet session, type quit and press the Enter key.  
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Accessing the NIDs 
The C4221 NIDs can be accessed through either a local serial interface via a USB connection or through 
an Ethernet network connection.  

Access via Local Serial Interface (USB) 
The C4221 NIDs can be connected to a local management station (PC) through a serial interface using a 
USB connection. The NID is controlled by entering command line interface (CLI) commands at the local 
management station. To use the serial interface (USB) the following is required: 

•  Personal computer (PC) 
•  USB cable (type A male connector on one end and type B male connector on the other) 
•  Terminal emulator program (e.g., HyperTerminal) on the PC 
•  USB driver installed on the PC 
•  Configured COM port 

IMPORTANT 

In order to control the chassis slide-in module through a USB serial interface, the command line prompt 
must be showing the location of the module to be managed. See the CLI Reference manual. 

Starting the Web Interface 
See the ION C4221 Web User Guide. 
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3:  Troubleshooting 
This section provides basic and specific problem determination processes, and a description of problem 
conditions that may occur or messages that may be displayed. This section also documents ION system 
tests and C4221 and jumper, and describes where and how to get technical support. 

IMPORTANT 

For each procedure described in this section, do each step sequentially as indicated. If the result of a 
step causes the problem to be corrected, do not continue with the other steps in the procedure. 

Basic ION System Troubleshooting 
This basic process is intended to provide some high-level techniques that have been found useful in  
isolating ION problems. This process is not a comprehensive guide to troubleshooting the ION system. 
The intent here is to 1) avoid missing any important information, 2) simplify analysis of captured  
information, and 3) improve accuracy in finding and explaining problem causes and solutions.  

This basic process applies to these ION system and related components: 

• ION Chassis 
• ION NIDs (SICs, or slide-in-cards) 
• IONMM 
• ION software (ION System Web UI or ION CLI).  
• ION power supply 
• ION Options (SFPs, ION LG Kit, etc.) 
• Data cables, electrical cables, and electrical outlets 
• Third party network equipment (circuit protection equipment, battery backup, 3rd party  

client or server software – RADIUS or TFTP, etc.) 

When troubleshooting an ION system / network problem on site:   

1. Document the operation taking place when the failure occurred.  
2. Capture as much information as possible surrounding the failure (the date and time,  

current configuration, the operation in process at the time the problem occurred, the step you 
were on in the process, etc.).  

3. Start a log of your ideas and actions, and record where you were in the overall scheme of the 
system process (i.e., initial installation, initial configuration, operation, re-configuration, upgrad-
ing, enabling or disabling a major feature or function, etc.).  

4. Write down the error indication (message, LED indicator, etc.). Take a screen capture if the  
problem displayed in software.  

5. Start with the most simple and work towards the more complex possible problem causes (e.g., 
check the network cables and connections, check the device LEDs, verify the NIDs are seated 
properly, view the CLI show command output, check the Syslog file, verify IP addresses and 
Gateway IP address, check Windows Event Viewer, ping the interface, run the various tests if 
functional, etc.). 

6. Write down your initial 2-3 guesses as to the cause of the problem. 
7. Verify that the product supports the function you are attempting to perform.  Your particular 

product or firmware version may not support all the features documented for this module.  
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For the latest feature information and caveats, see the release notes for your particular de-
vice/system and firmware release. 

8. Use the Web interface or command line interface (CLI) to obtain all possible operating status 
information (log files, test results, show command outputs, counters, etc.)  

9. If LOAM is configured, check the LOAM Event Log table parameters,. Print the output if possible.  
10. Use the ION system manual procedure to retry the failed function or operation.  
11. For the failed function or operation, verify that you entered valid parameters using the cursor-

over-help (COH) and/or the ION system manual.  
12. Based on the symptoms recorded, work back through each step in the process or operation to 

recall a point at which the problem occurred, and examine for a possible failure point and fixe 
for each.  

13. Document each suspected problem and attempted resolution; eliminate as many potential 
causes as possible.  

14. Isolate on the 1-2 most likely root causes of what went wrong, and gain as much information as 
you can to prove the suspected cause(s). 

15. If you find a sequence of actions that causes the problem to recur, replicate the full sequence 
several times and document it if possible.  

16. Review your logged information and add any other comments that occur to you about what has 
taken place in terms of system behavior and suspected problem causes and solutions.  

17. Review the “Recording Model Information and System Information” section before calling for 
Technical Support.  

Error Indications and Recovery Procedures 

The types of indications or messages reported include: 

• LED Fault and Activity Displays  
• Check the PCB configuration. See “Jumper Settings”. 
• Problem Conditions  
• CLI Messages  
• Web Interface Messages  
• Windows Event Viewer Messages  
• Config Error Log (config.err) File  
• Webpage Messages   

These message types and their recommended recovery procedures are covered in the related manuals. 
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LED Fault and Activity Displays 
Refer to this section if the LEDs indicate a problem. For any LED problem indication, review the  
“Connections and LEDs” section, and then perform the following steps.  

1. Check the power cord connections and power outlet.   
2. Check the data cables for obvious problems, incorrect cable type, incorrect wiring, etc.  
3. Make sure the USB cable is properly connected. 
4. Check the power supply voltages (see related documentation).   
5. Verify that the ION system devices have the latest firmware versions. Download the latest firm-

ware version and upgrade as necessary. 
6. Check if other network devices are working properly.  

Power (PWR) LED is off (not lit): 

1. Check for a loose power cord.  
2. Check for a power supply failure. Replace power supply if failed.  
3. Make sure all circuit protection and connection equipment and devices are working. 
4. Verify that the ION system power supply is within operating range.  
5. Remove the card from the chassis and re-insert it. Replace if failed. 
6. Make sure the mode displayed matches the hardware setting on the device. See the “Jumper 

Settings” section. 

LACT (Link Activity) LED off (not lit): 

1. Check the data cables for obvious problems, incorrect type, incorrect wiring, etc.  
2. See if the administrator has manually disabled the console device (PC) via the Web interface.  
3. Check if other network devices are working properly.  
4. Remove the suspect card from the chassis and re-insert it. 
5. Check Auto-Negotiation setting. 
6. See if the port transmission mode / speed (full or half-duplex, etc.) match those of the  

attached device. 
7. Verify that the ION system devices have the latest firmware versions (see the related manual). 

Download the latest firmware version and upgrade as necessary. 

Fault LED is lit:  

1. Check for a problem with the IONMM, software, or configuration.  
2. Make sure all circuit protection and connection equipment and devices are working. 
3. Verify that the ION system power supply is within operating range. 
4. Remove the card from the chassis and re-insert it. 
5. Make sure the USB cable is properly connected. 
6. Reset the IONMM. 

TX or RX LED off (not flashing):  

1. Check the data cables for obvious problems, incorrect cable type, incorrect wiring, etc.  
2. Check if other network devices are working properly.  
3. Verify that the ION system devices have the latest firmware versions. 
4. Download the latest firmware version and upgrade as necessary.  
5. Remove the card from the chassis and re-insert it. 
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Jumper Settings 

The C4221 NIDs has an on-board component that can be used to configure device operation, typically at 
the direction of a Technical Support specialist. In most cases, the factory default settings provide optimal 
configuration settings; however, Jumper setting changes may be required for operating mode changes 
or troubleshooting purposes.  

PCB Identification 
This section covers the following PCB (printed circuit board) for the C4221 NID - PCB: 11546 Rev. A (this 
information is silkscreened on the bottom of the PCB). The PCB has one jumper.  

Note: Do not change the jumper setting except at the direction of a Technical Support specialist.  

PCB Layout  
PCB: 11546 Rev. A (this information is silkscreened on the bottom of the PCB). This PCB has one jumper 
(J9) used in the field.  
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J9 – Reset to Factory Defaults (N/F) 

  Doing a Reset To Factory Config resets the NID configuration to the 
state it was in when it shipped from the factory. This permanently removes 
all current configuration details and loads the system configuration with the 
factory default settings. See also “Reset To Factory Config” via the CLI or 
Web UI in the related manual.  

        
 

 

 J9 

Jumper 
Pin #s  Function  
1-2 (N)  Normal (factory default position). 
2-3 (F)  Reset the unit to Factory defaults including  
                             resetting the IP address.  
 

Procedure 

1. Back up the current configuration (config file) if required.  
2. Remove the C4221 card from the ION chassis.  
3. On Jumper J9, move the shunt (shorting plug) from pins 1 and 2 to pins 2 and 3.  
4. Replace the C4221 card in the ION chassis.  
5. Wait for the L/A LED to stop blinking, then wait for 30 more seconds for the changes to occur. 
6. After 30 seconds, remove the C4221 from the ION chassis, move the J9 shunt back to pins 1 and 

2, replace the C4221 card in the ION chassis, and Restore the saved config file. 

J12 (Not Used) 
Do not use. Jumper J12 is used for manufacturing / debug purposes only.  

J8 (Not Used)  
Do not use. Jumper J8 is used for manufacturing / debug purposes only.  
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Cable Specifications 
The physical characteristics must meet or exceed IEEE 802.3™ specifications. 

Fiber port: SFP+, both Class-I and Class-II, 10.3125Gbps.  
Copper port: RJ-45, 10Gbps. 

Copper Cable 
Category 6a (minimum requirement) 
Maximum Cable Distance:  100 meters 

• Straight-through or crossover twisted-pair cable may be used. 
• Shielded (STP) or unshielded (UTP) twisted-pair cable may be used. 
• All pin pairs (1&2, 3&6, 4&5, 7&8) are active pins in a 10GB Ethernet network. 
• Use only dedicated wire pairs for the active pins (e.g., blue/white & white/blue, orange/white & 

white/orange, etc.) 
• Do not use flat or silver satin wire. 

 

Cable Types 
The cabling specifications are provided for troubleshooting purposes.  
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Copper (TP / UTP) CAT 1 – CAT 7 Cabling 
ANSI/EIA Standard 568 is one of several standards that specify "categories" (each a "CAT") of twisted 
pair cabling systems. Assigned by the American National Standards Institute/Electronic Industries Associ-
ation, these standards categories include CAT 1 – CAT 7, as shown below.  

Table 4: Copper Cable Descriptions 

Category Max Data Rate Typical Application 

CAT 5 100 MHz 100 Mbps TPDDI. 155 Mbps ATM. No longer sup-
ported; replaced by 5E. 10/100BASE-T. 

CAT 5E 100 MHz 100 Mbps TPDDI, 155 Mbps ATM, Gigabit Ethernet. Of-
fers better near-end crosstalk than CAT 5. 

CAT 6 Up to 250 MHz Minimum cabling required for data centers in TIA-942.  
CAT 6 is quickly replacing CAT 5e. 

CAT 6a Up to 500 MHz 

Field-tested to 500 MHz. Supports 10 Gigabit Ethernet 
(10GBASE-T). May be either shielded (STP, ScTP, 
S/FTP) or unshielded (UTP). Standard published in Feb. 
2008. The minimum requirement for Data Centers in 
the ISO Data Center standard. 

CAT 7 (ISO Class F) 
600 MHz, 1.2 GHz in 
pairs with Siemon 
connector 

Full-motion video, Teleradiology, Government and 
manufacturing environments. Fully Shielded (S/FTP) 
system using non-RJ45 connectors but backwards 
compatible with hybrid cords. Standard published in 
2002. Until Feb. 2008, the only standard to support 
10GBASE-T for a full 100m. 

 
CAT 7A/Class FA and Category 6A/Class EA specifications were published in February, 2008. 
Common forms of 10GbE copper cables include: 

10GBASE-CR: currently the most common type of copper 10GbE cable is the 10GBase-CR cable that uses 
an attached SFP+ connector, also known as a Direct Attach Copper (DAC). This fits into the same form 
factor connector and housing as the fiber-optic cables with SFP+ connectors. Many 10GbE switches ac-
cept cables with SFP+ connectors, which support both copper and fiber-optic cables. These cables are 
available in 1m, 3m, 5m, 7m, 8.5m and longer distances. The most commonly deployed distances are 3m 
and 5m. 

Passive and Active DAC: Passive copper connections are common with many interfaces. The industry is 
finding that as the transfer rates increase, passive copper does not provide the distance needed and 
takes up too much physical space. The industry is moving towards an active copper type of interface for 
higher speed connections. Active copper connections include components that boost the signal, reduce 
the noise and work with smaller gauge cables, improving signal distance, cable flexibility and airflow. 

10GBASE-T: These cables and connectors are similar to, but not the same as the cables used for 
1000BASE-T.10GBASE-T cables are Cat6a (Category 6 augmented), also known as Class EA cables. These 
support the higher frequencies required for 10Gb transmission up to 100 meters (330 feet). Cables must 
be certified to at least 500MHz to ensure 10GBASE-T compliance. Cat7 (Category 7, Class F) cable is also 
certified for 10GBASE-T compliance, and is typically deployed in Europe. Cat6 cables may work in 
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10GBASE-T deployments up to 55m, but should be tested first. Some newer 10GbE switches support 
10GBASE-T (RJ45) connectors. 

Cat 6 (Category 6) Copper Cable 
Category 6 cable, commonly referred to as Cat 6, is a standardized cable for Gigabit Ethernet and other 
network physical layers that is backward compatible with the Category 5/5e and Category 3 cable stand-
ards. Compared to Cat 5 and Cat 5e, Cat 6 provides more stringent specifications for crosstalk and sys-
tem noise. The Cat 6 cable standard provides performance of up to 250 MHz and is suitable for 10BASE-
T, 100BASE-TX (Fast Ethernet), 1000BASE-T/1000BASE-TX (Gigabit Ethernet) and 10GBASE-T (10-Gigabit 
Ethernet). 

Category 6 cable has a reduced maximum length when used for 10GBASE-T.  

Like most of the earlier twisted-pair cables, Category 6 cable contains four twisted wire pairs. Attenua-
tion, near end crosstalk (NEXT), and PSNEXT (power sum NEXT) in Cat 6 cable and connectors are all 
much lower than Cat 5 or Cat 5e, which uses 24 AWG wire. The increase in performance with Cat 6 
comes mainly from increased (22 AWG) wire size. Because the conductor sizes are generally the same, 
Cat 6 jacks may also be used with Cat 5e cable. 

Category 6 cable can be identified by the printing on the side of the cable sheath. Cat 6 patch cables are 
normally terminated in 8P8C modular connectors. If Cat 6 rated patch cables, jacks, and connectors are 
not used with Cat 6 wiring, overall performance is degraded to that of the cable or connector.  

Connectors use either T568A or T568B pin assignments; although performance is comparable provided 
both ends of a cable are the same, T568B is a deprecated standard in the US and no longer supported by 
TIA. 

Category 6a Copper Cable (Augmented Category 6) 
Category 6a cable, or Augmented Category 6, is characterized to 500 MHz and has improved alien cross-
talk characteristics, allowing 10GBASE-T to be run for the same distance as previous protocols.  

The latest standard from the TIA for enhanced performance standards for twisted pair cable systems 
was defined in February 2008 in ANSI/TIA/EIA-568-B.2-10. Category 6a is defined at frequencies up to 
500 MHz—twice that of Cat. 6. Category 6a performs at improved specifications, in particular in the area 
of alien crosstalk, as compared to Cat 6 UTP (unshielded twisted pair), which exhibited high alien noise 
in high frequencies. 

The global cabling standard ISO/IEC 11801 has been extended by the addition of amendment 2, which 
defines new specifications for Cat 6A components and Class EA permanent links. These new global Cat 
6A/Class EA specifications require a new generation of connecting hardware, which offer superior per-
formance compared to existing products based on the American TIA standard. 

Note the performance difference between ISO/IEC and EIA/TIA component specifications for the NEXT 
transmission parameter. At a frequency of 500 MHz, an ISO/IEC Cat 6A connector performs 3 dB better 
than a Cat 6A connector that conforms to the EIA/TIA specification. The 3 dB represents a 100% increase 
of near-end crosstalk noise reduction when measured in absolute magnitudes.  
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Maximum Length 
When used for 10/100/1000BASE-T, the maximum allowed length of a Cat 6 cable is 100 meters or 328 
feet. This consists of 90 meters (300 ft.) of solid "horizontal" cabling between the patch panel and the 
wall jack, plus 10 meters (33 ft.) of stranded patch cable between each jack and the attached device. 
Since stranded cable has higher attenuation than solid cable, exceeding 10 meters of patch cabling will 
reduce the permissible length of horizontal cable. 

When used for 10GBASE-T, Cat 6 cable's maximum length is 55 meters (180 ft.) in a favorable alien 
crosstalk environment, but only 37 meters (121 ft.) in a hostile alien crosstalk environment, such as 
when many cables are bundled together. However, because the effects of alien crosstalk environments 
on cables are difficult to determine prior to installation, it is highly recommended that all Cat 6 cables 
being used for 10GBASE-T are electrically tested once installed. With its improved specifications, Cat6 A 
does not have this limitation and can run 10GBASE-T at 100 meters (330 ft.) without electronic testing. 
 
Installation Notes 
Category 6 and 6a cable must be properly installed and terminated to meet specifications. The cable 
must not be kinked or bent too tightly (the bend radius should be at least four times the outer diameter 
of the cable). The wire pairs must not be untwisted and the outer jacket must not be stripped back more 
than 1/2 inch (1.27 cm). 

All shielded cables must be grounded for safety and effectiveness and a continuous shield connection 
maintained from end to end. Ground loops develop when there is more than one ground connection 
and the difference in common mode voltage potential at these ground connections introduces noise 
into the cabling. 

Note that 23 or 24 AWG wire is allowed if the ANSI/TIA-568-B.2-1 performance specifications are met. 
The figure below shows the pins on plug face; note that the socket is the reverse of the plug pinout 
shown below. For more information, see the TIA web site or the IEEE web site.  

 
Figure 20: Category 6 Plug Face Pins 
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Troubleshooting Cat 6 & Cat 6a Structured Copper Cabling Systems 
If a Category 6 cabling system does not meet the electrical requirements for supporting 10GBASE-T  
applications, see the TSB-155 provided guidelines designed to mitigate the alien crosstalk between the 
target pair and the disturbing pairs of Category 6 channels and permanent links. Annex B of TSB-155  
outlines the following mitigation actions most appropriate for individual situations: 

• Use Category 6 shielded or Category 6a patch cords; 
• Replace Category 6 connectors with Category 6a connectors; 
• Use non-adjacent patch panel positions; 
• Separate equipment cords and patch cords; 
• Unbundle or more loosely bundle the horizontal cabling; and 
• Reconfigure the cross-connect as an interconnect. 

Fiber (10GbE) Cabling 

The two general types of fiber optic cables are SMF (single-mode fiber) and MMF (multi-mode fiber). 

SMF has an optical core of approximately 9 μm (microns), and has lower modal dispersion than MMF, 
and can support distances of at least 10 Km and as high as 80-100 Km (Kilometers) or more, depending 
on transmission speed, transceivers, etc.. 

MMF has an optical core of either 50 μm or 62.5 μm, and it supports distances up to 600 meters, de-
pending on transmission speeds and transceivers. 

Table 8: Fiber Cable Descriptions 

Standard Cable Type 
Core  

Diameter 
IEEE Standard 

Distance 
Wavelength 

OM1  Multi-mode (MMF) 62.5/125 μm 33 meters (SR) 850 / 1300 nm 

OM2  Multi-mode (MMF) 50/125 μm 82 meters (SR) 850 / 1300 nm 

OM3  Multi-mode (MMF) 50/125 μm 300 meters (SR) 850 / 1300 nm 

OM4  Multi-mode (MMF) 50/125 μm 550 meters (SR) 850 / 1300 nm 

OS1 Single mode (SMF) 9 μm up to 10,000m 1310 / 1550 nm 
 
OS1 SMF optics are used for distances up to 10,000m (6.2 miles) with standard transceivers and can 
work at longer distances with special transceivers and switching infrastructure.  
 
The C4221 supports:  

10GBase-SR:  The most common type of fiber-optic 10GbE cable that supports an SFP+ connector with 
an optical transceiver rated for 10Gb transmission speed (also known as “short reach” fiber-optic ca-
bles). 

10GBase-LR: The “long reach” fiber optic cables that support single-mode fiber optic cables and con-
nectors. Provides serialized data at a line rate of 10.3125 Gbit/s.10GBASE-LR has a specified reach of 10 
kilometers (6.2 mi), but 10GBASE-LR optical modules can often manage distances of up to 25 kilometers 
(16 mi) with no data loss. 

https://www.lantronix.com/
http://www.ieee802.org/3/an/public/nov04/TR42.7-04-10-142a-TSB155_d1.1a.pdf
http://www.ieee802.org/3/an/public/jul04/TR427_TSB155-d1.0-release.pdf


Lantronix                  ION C4221 Install Guide 

33692 Rev. C  https://www.lantronix.com/ Page 32 of 38 

10GBase-ER: The "extended reach" port type for single-mode fiber that uses 1550 nm lasers. Its Physical 
Coding Sublayer 64b/66b PCS is defined in IEEE 802.3 Clause 49 and its Physical Medium Dependent 
PMD in Clause 52. It delivers serialized data at a line rate of 10.3125 Gbit/s. 

10GBase-ZR: An 80 km (50 mile) range ER pluggable interface, the 80 km PHY is not specified within the 
IEEE 802.3ae standard, and manufacturers have created their own specifications based on the 80 km 
PHY described in the OC-192/STM-64 SDH/SONET specifications. 

10GBase-LRM: The “Long Reach Multimode” originally specified in IEEE 802.3aq; a port type for multi-
mode fiber that uses 1310 nm lasers. Its Physical Coding Sublayer 64b/66b PCS is defined in IEEE 802.3 
Clause 49 and its Physical Medium Dependent PMD is defined in Clause 68. It delivers serialized data at a 
line rate of 10.3125 Gbit/s. 10GBASE-LRM supports distances up to 220 meters (720 ft.) on FDDI-grade 
multimode fiber and the same 220m maximum reach on OM1, OM2 and OM3 fiber types. 

The C4221 does not support 10GBase-LX4 or 10GBase-CX4.  
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Recording Model Information and System Information 
After performing the troubleshooting procedures, and before calling or emailing Technical Support, 
please record as much information as possible to help the Technical Support Engineer. 

1. Select the device MAIN tab. (From the CLI, use the commands needed to gather the information 
requested below, such as show card info, show slot info, show system info, show ether config, or 
others as requested by the Technical Support Engineer.)  

 

2. Record the Model Information for your system. 

Serial Number: ________________________ Model:  _________________________________ 

Software Revision: ____________________ _ Hardware Revision: ________________________ 

Bootloader Revision: __________________  System Up Time: __________________________ 

3. Record the System Configuration information for your system. 

Configuration Mode: __________________  Number of Ports:  _____________________ _  

MAC Address: __________________________  Device Description: _______________________   

4. Provide additional Model and System information to your Technical Support Specialist. See “Basic 
ION System Troubleshooting”.  

Your Lantronix service contract number: ______________________________________ 

A description of the failure: ____________________________________________________________ 

___________________________________________________________________________________ 

___________________________________________________________________________________ 
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A description of any action(s) already taken to resolve the problem (e.g., changing switch mode, 
rebooting, etc.): _____________________________________________________________________ 

__________________________________________________________________________________ 

__________________________________________________________________________________ 

The serial and revision numbers of all involved Lantronix products in the network: 
__________________________________________________________________________________ 

__________________________________________________________________________________ 

A description of your network environment (layout, cable type, PC, OS, browser, etc.): _____________ 

___________________________________________________________________________________ 

___________________________________________________________________________________ 

Network load and frame size at the time of trouble (if known): ________________________________ 

The device history (i.e., have you returned the device before, is this a recurring problem, etc.): 
__________________________________________________________________________________ 

__________________________________________________________________________________ 

Any previous Return Material Authorization (RMA) numbers: ________________________________ 

Note: The model number, Serial Number, and Firmware Rev. are on a printed label on the bottom of the 
ION NID.  
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Appendix A:  Compliance Information 
Standards    CISPR22/EN55022 Class A, CE Mark 

FCC Regulations   

 NOTE: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense. 

CE Marking 

This is a Class A product. In a domestic environment, this product could cause radio interference; as a 
result, the customer may be required to take adequate preventative measures. 

Canadian Regulations 

This Class A digital apparatus complies with Canadian ICES-003. 

French: Cet appareil numériqué de la classe A est conformé à la norme NMB-003 du Canada. 

European Regulations 

WARNING: 

This is a Class A product. In a domestic environment, this product could cause radio interference in 
which case the user may be required to take adequate measures. 

Achtung ! 

Dieses ist ein Gerät der Funkstörgrenzwertklasse A. In Wohnbereichen können bei Betrieb dieses 
Gerätes Rundfunkstörungen auftreten.  In diesem Fäll ist der Benutzer für Gegenmaßnahmen 
verantwortlich. 

NDAA, RoHS, REACH and WEEE Compliance 
See the compliance webpage at https://www.lantronix.com/legal/rohs/.  

Trade Agreement Act (TAA) Compliant Products  
See the TAA webpage at https://www.lantronix.com/legal/rohs/taa-compliant-products/.   

Accessibility Statement  
In our effort to help provide a fully accessible and optimized experience for our website visitors, lantro-
nix.com has taken careful measures to help ensure an enhanced user experience, whether the website 
visitor is using assistive technologies such as a screen reader, magnifier or other assistive technology to 
access the website. For more information see our webpage at https://www.lantronix.com/accessibility-
statement/.  
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Attention ! 

Ceci est un produit de Classe A.  Dans un environment domestique, ce produit risque de créer des 
interférences radioélectriques, il appartiendra alors à l’utilsateur de prende les measures spécifiques 
appropriées. 

  In accordance with European Union Directive 2002/96/EC of the European Parliament and of 
the Council of 27 January 2003, Lantronix will accept post usage returns of this product for 
proper disposal. The contact information for this activity can be found in the ‘Contact Us’ 
portion of this document. 

CAUTION: RJ connectors are NOT INTENDED FOR CONNECTION TO THE PUBLIC TELEPHONE 
NETWORK. Failure to observe this caution could result in damage to the public telephone 
network. 

Der Anschluss dieses Gerätes an ein öffentlickes Telekommunikationsnetz in den EG-Mitgliedstaaten 
verstösst gegen die jeweligen einzelstaatlichen Gesetze zur Anwendung der Richtlinie 91/263/EWG zur 
Angleichung der Rechtsvorschriften der Mitgliedstaaten über Telekommunikationsendeinrichtungen 
einschliesslich der gegenseitigen Anerkennung ihrer Konformität. 

Declaration of Conformity 
Manufacture’s Name: Lantronix, Inc. 
Manufacture’s Address: 48 Discovery, Suite 250, Irvine, California 92618 USA 

Declares that the product(s):  
C4221-4848 
S4221-4848 

Conforms to the following Product Regulations: 
FCC Part 15 Class A; EN55032-2012  
EN55024-2010; Directive 2004/108/EU  
Low Voltage Directive 2014/36/EC  
IEC/EN 60950-1:2006+A2:2013 
2011/65/EU EN50581:2012 

With the technical construction on file at the above address, this product carries the CE Mark 

I, the undersigned, hereby declare that the equipment specified above conforms to the above Directive(s) 
and Standard(s). 
Place: Irvine, California 
Date: April 27, 2023 
Signature: Eric Bass 
Full Name: Eric Bass 
Position: Vice President of Engineering 
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Electrical Safety Warnings  

Electrical Safety 

IMPORTANT: This equipment must be installed in accordance with safety precautions. 

Elektrische Sicherheit 

WICHTIG: Für die Installation dieses Gerätes ist die Einhaltung von Sicherheitsvorkehrungen 
erforderlich. 

Elektrisk sikkerhed 

VIGTIGT: Dette udstyr skal enstallers i overensstemmelse med sikkerhedsadvarslerne. 

Elektrische veiligheid 

BELANGRIJK: Dit apparaat moet in overeenstemming met de veiligheidsvoorschriften worden 
geïnstalleerd. 

Sécurité électrique 

IMPORTANT : Cet équipement doit être utilisé conformément aux instructions de sécurité. 

Sähköturvallisuus 

TÄRKEÄÄ : Tämä laite on asennettava turvaohjeiden mukaisesti. 

Sicurezza elettrica 

IMPORTANTE: questa apparecchiatura deve essere installata rispettando le norme di sicurezza. 

Elektrisk sikkerhet 

VIKTIG: Dette utstyret skal 37installers i samsvar med sikkerhetsregler. 

Segurança eléctrica 

IMPORTANTE: Este equipamento tem que ser instalado segundo as medidas de precaução de 
segurança. 

Seguridad eléctrica 

IMPORTANTE: La instalación de este equipo deberá llevarse a cabo cumpliendo con las precauciones de 
seguridad. 

Elsäkerhet 

OBS! Alla nödvändiga försiktighetsåtgärder måste vidtas när denna utrustning används.
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Lantronix Corporate Headquarters 
48 Discovery 
Suite 250 
Irvine, CA 92618, USA 
Toll Free: 800-526-8766 
Phone: 949-453-3990 
Fax: 949-453-3995 
Technical Support 
Online: https://www.lantronix.com/technical-support/  
Sales Offices 
For a current list of our domestic and international sales offices, go to the Lantronix web site at 
www.lantronix.com/about/contact.  
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